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About these release notes

These release notes provide a list of new features, known issues, and other
important last-minute information applicable to using Matrox Mtx.utils version
7.7.2. This information supplements the Matrox MXO?2 Installation and User
Guide, which is provided in PDF format in the Matrox MXO2 Support section of
our website at www.matrox.com/video/support.

Visit our website for the latest downloads

To ensure that you have the latest software updates and documentation available
for your Matrox MXO2 system, check the Matrox MXO2 Support section of our
website at www.matrox.com/video/support. Our website also offers
up-to-the-minute information about Matrox products, access to our user forums,
and special promotional offers.

What’s new in this release?

Matrox Mtx.utils 7.7.2 provides the following new features for Matrox MX02
products:
* Support for Avid Media Composer 8.3

* Solutions to specific customer issues, compatibility with the latest supported
applications, and overall product stability improvement.

Installing this release
@ Important For a complete list of the third-party applications supported for

using Matrox MXO2 with the current software release, see the “Supported OS
and Applications” document provided in the “Downloads” section of the Matrox
MXO?2 Support website. If needed, uninstall any previous version of Matrox
Mtx.utils before upgrading to the currently supported version of your third-party
software.

You can download and install the Matrox Mtx.utils version 7.7.2 software from
the Matrox MXO2 Support section of our website at
www.matrox.com/video/support. Before installing Matrox Mtx.utils, make sure
that you’ve installed the third-party software that you’ll be using with MXO2.
Adobe Premiere Pro must be installed if you want to use Adobe Mercury
Transmit for playback on your Matrox hardware with Adobe Prelude.

Note Matrox Mtx.utils installs software for MXO2 as well as the Matrox
CompressHD card so that you can use your MXO2 hardware with CompressHD.
If you want to use a Matrox Convert DVI product with MXO2 on the same
system, you must install Matrox MtxConvert.utils instead of Matrox Mtx.utils.
Matrox MtxConvert.utils is available in the “Downloads” section of the Matrox
Support website under “Combo Software” for your Convert DVI product.
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Known issues

Please be aware of the following issues when using Matrox MXO2 products with
Matrox Mtx.utils version 7.7.2:

Installation and general operation
* When installing Matrox Mtx.utils, you may receive a message that some
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device drivers have not been installed successfully. You can ignore this
message, as the device drivers will be successfully installed once the
Mitx.utils installation is complete. (Ref# 52208)

After adding a Matrox CompressHD card to your Matrox MXO?2 system,
even though Matrox X.info detects your new hardware, the Matrox presets
for encoding to Matrox H.264 Blu-ray format may not be present in Adobe
Encore. If this happens, uninstall and re-install Matrox Mtx.utils. (Ref#
56582)

If you installed Matrox Mtx.utils without your Matrox MXO2 hardware
connected to your computer, you may experience problems trying to use
your MXO2 system when you connect your MXO2 hardware for the first
time. If this happens, restart your system. (Ref# 51673)

To improve the brightness of live video windows in Matrox applications
(such as the preview window in Matrox A/V Tools) on a system that has an
NVIDIA display card, use your display card’s control panel to set the
dynamic range for video to full. In the NVIDIA Control Panel under Video,
select Adjust video color settings. In the displayed dialog box, select
With the NVIDIA settings, click the Advanced tab, and from the
Dynamic range list, select Full (0-255). Apply this setting to all the
displays on which you preview video using Matrox applications. (Ref#
56660)

To avoid issues when using applications that have a live video window on a
Matrox MXO2 system with an NVIDIA display card, it’s recommended that
you use your display card’s control panel to turn off the vertical sync for
each program that you use with your Matrox video hardware. In the NVIDIA
Control Panel, select Manage 3D Settings, click the Program Settings
tab, select a program to customize, such as Adobe Premiere, and then set
Vertical sync to Force off. (Ref# VPG-3465)

When using the HDMI output from an Xbox as your input source with
MXO?2 hardware, the audio output from MXO2 may be distorted. To correct
the audio distortion, switch the video output setting of your Xbox to 480p,
and then back to your original HD output setting, such as 1080i. In order to
see your Xbox video display while making your setting changes, you may
need to connect the HDMI output from your Xbox to an HDMI monitor or
other HDMI display device. After doing this, remember to reconnect the
HDMI output to MXO2. (Ref# 54132)



¢ Some programs may include the Matrox ASIO driver in their list of available
audio drivers. This driver, however, can be used only with Adobe Premiere
Pro. The driver is named Matrox ASIO Driver for Adobe Premiere Pro to
help avoid confusion. (Ref# VPG-5067)

* If you connect multiple MXO2 devices to your desktop computer and you
later want to disconnect any of these devices from your system, you must
disconnect all your MXO2 devices. When you reconnect these devices, you
must connect each MXO?2 device to the same Matrox adapter to which it was
originally connected. Otherwise, your system may become unstable. If this
happens, uninstall and re-install your Matrox Mtx.utils software. (Ref#
VPG-6174)

Adobe Premiere Pro
» If you are using a NVIDIA Quadro display card, and you experience lag in
Adobe Premiere Pro, please install version 333.11 of the NVIDIA Quadro
display drivers. (Ref# VPG-11065)

» To avoid having dropped frames in your Adobe Premiere Pro CC sequences
with closed captioning text, place your closed caption file on the lowest
video track (V1) and place your video and graphics clips on the tracks above
the closed captioning text. If you’ve done this and you experience dropped
frames when performing an export to tape, disable hardware rendering and
playback in your project, and choose to keep any rendered preview files that
you’ve created. To do this, choose File > Project Settings > General, and
under Video Rendering and Playback, select Mercury Playback Engine
Software Only. (Ref# VPG-6514)

* When using Matrox voice-over in a sequence that has an audio sample rate
other than 48000 Hz, the audio output from MXO2 won’t be available. This
issue, however, does not affect the recorded .wav file. (Ref# VPG-5049)

» If you're using the Matrox MPEG-2 I-frame codec for rendering video
previews in an NTSC or 486p sequence, when you change the MPEG-2
I-frame data rate, your change may not be retained when you save your
settings, and instead the data rate may revert back to the default setting of 25
Mb/sec. (Ref# VPG-2794)

» If Adobe Premiere Pro quits while starting or the Matrox settings are
missing, press and hold SHIFT+ALT while restarting Premiere Pro. You can
release the SHIFT+ALT keys when the splash screen appears. Because this
will restore your preferences to default settings, you’ll need to specify your
preferences again using Edit > Preferences. (Ref# 57016 and VPG-1659)

e In order to perform an audio-only capture using Matrox MXO2, you must set
the Input Type to Consumer-quality Source and select a component
video input source in the Matrox Capture Settings dialog box, although
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the video input source doesn’t need to be connected. (Ref# VPG-175 and
VPG-2567)

When switching between Adobe DV/HDV device control and Matrox
RS-422 device control, the video preview in the Capture panel may go
blank when you play back your source video. If this happens, close the
Capture panel and re-open it. (Ref# 57284)

When using Matrox RS-422 device control, the capture does not stop at the
end of your tape when using the Tape feature in the Capture panel. To avoid
capturing past the end of your tape, use the In/Out capture feature instead
and set In and Out points for your capture. (Ref# VPG-3550)

The Panasonic AJ-HD1200A does not have auto edit capabilities and will
not be frame accurate when using Matrox RS-422 device control. (Ref#
VPG-3812)

When using Matrox RS-422 device control to record a 1080p @ 23.98 fps
sequence to an NTSC deck, the deck may not start recording if you set the
time base for the Matrox RS-422 device control settings to 30 fps. If this
happens, change the time base to 24 fps and perform the export to tape again.
(Ref# 56656)

When using Matrox RS-422 device control to capture a clip with set In and
Out points, if you press ESC to stop the VTR while seeking to the In point,
the VTR won’t stop immediately, but will stop once it reaches the In point.
(Ref# 54144)

When capturing the HDMI video input from a laptop, make sure that the
refresh rate of your source video is compatible with the frame rate to which
you are capturing. For example, to capture to video formats that have a frame
rate of 29.97 or 59.94, the refresh rate (display resolution) of your input
video must be 60 Hz. To capture to video formats that have a frame rate of
25 or 50, your input video’s refresh rate must be 50 Hz. (Ref# 54485)

If you experience issues when exporting a clip that has an empty audio track
from an Adobe Premiere Pro sequence or using the clip with another Adobe
program via Dynamic Link, do the following:

1 In the \Media Cache Files folder for your project, delete the .cfa and .pek
files for the clip that has the empty audio track.
2 Restart Premiere Pro and open your project again. (Ref# 53291)

If you cancel a capture to a Matrox .m2v file, the captured .m2v file will be
deleted, but any associated .wav files won’t be deleted. You’ll need to delete
the .wav files manually. (Ref# 51124)

When you select 24-bit as your Capture Format on the Audio Capture
Settings page for a Matrox .m2v capture, your audio files are captured in



24-bit format, but Premiere Pro will display the properties of the audio files
as 32-bit. (Ref# 51147)

To avoid problems when capturing clips, rendering previews, or exporting

your sequence to disk, make sure that the total length of your Premiere Pro
project’s folder path name and file name is not longer than 128 characters.

(Ref# 49841).

When creating a Matrox wipe transition, you may see dotted lines in your
output. To eliminate the dotted lines, apply softness to the wipe. (Ref#
33122)

When you import DV and MPEG-2 I-frame video clips with a 720x480
resolution into a sequence that has a Matrox codec editing mode, the image
size displayed in the Project panel and the Properties window will be
720% 486. To see the real resolution of the clip, look at the Actual Image
Size in the Properties window. Your clips will be processed and output
correctly when you export to file or print to tape. (Ref# 31737)

If you use the Customize Matrox Wipes dialog box to make changes to a
Matrox transition after it has been rendered, the changes you make will not
be updated in the Transition preview or on your Program Monitor until you
click OK. (Ref# 39018)

When capturing material from a tape with a bad video signal, you may
receive a Macromedia error and the captured footage will consist of blue or
black video. (Ref# 40496)

If you have multiple Matrox wipe transitions in a sequence, and you modify
the default transition and save it, any previous wipes that were applied using
default transition settings will have the new default transition settings
applied as well. Wipe transitions that were not applied with default wipe
transition settings won’t be affected. (Ref# 41988)

If you trim a project that contains .avi files created using a Matrox VFW
MPEG-2 I-frame or a Matrox VFW Uncompressed codec and the audio for
the files is not 48,000 kHz, those files may be offline when you open the
trimmed project. To avoid this problem, set the audio to 48,000 kHz when
creating the files. (Ref# 41996)

If your hard drive is almost full when you capture clips, Adobe Premiere Pro
will issue a warning message and may become unresponsive after you click
OK and close the Capture panel. (Ref# 42634)

You can’t export clips that have mono audio to a Matrox .avi file from Adobe
Premiere Pro’s Project panel. (Ref# 42183)

To avoid problems when capturing clips, rendering previews, or exporting
your sequence to disk, make sure that the total length of your Premiere Pro
project’s folder path name and file name is not longer than 128 characters.
(Ref# 49841).
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* If you choose to capture a video source for which a video input signal is not

detected from your Matrox MXO2 hardware, the input signal may display as
blue video (instead of black video). (Ref# 50156)

The first time you capture to a Matrox .avi file using Adobe Premiere Pro
after installing Matrox Mtx.utils, you need to configure your Matrox .avi
capture settings using Project Settings > General. From the Capture
Format list, select Matrox AVI and click Configure. (Ref# 50243)

e When you export an NTSC or PAL clip using the Matrox DV/DVCAM

codec, your exported clip may appear darker than the original clip. As a
workaround, use Adobe Premiere Pro’s DV NTSC or DV PAL codec to
export your NTSC or PAL clips to DV format. (Ref# 50460)

Adobe Media Encoder

Note If you're using Adobe Media Encoder for Matrox MAX H.264 encoding,
see also “Matrox MAX H.264 encoding (MAX option)” on page 8.

e When you export a PAL sequence that has a Matrox codec editing mode in

Adobe Premiere Pro to MPEG2-DVD format using Adobe Media Encoder,
set the Field Order to Upper under Basic Video Settings in the Export
Settings dialog box. Otherwise, your export may be blurry. (Ref# 51007)

Adobe Encore

Note If you're using Adobe Encore for Matrox MAX H.264 encoding, see also
“Matrox MAX H.264 encoding (MAX option)” on page 8.

* Adobe Encore may crash when you use the application for the first time after

installing Matrox Mtx.utils. If this happens, turn off User Account Control
(UACQ), then restart Adobe Encore. When you quit Adobe Encore, you can
turn UAC back on. For details on how to turn UAC on or off, see your
Windows documentation. (Ref# 54385)

When you import Matrox 1440x 1080 MPEG-2 I-frame clips into an Adobe
Encore project, the clips may be imported with an incorrect pixel aspect

ratio. To correct this, use the Interpret Footage command to change the
pixel aspect ratio of the clips to HD Anamorphic (1.333). (Ref# 54886)

Avid editing applications
* You may experience issues when running Avid Media Composer 6.0.x at the
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same time as another application that uses your Matrox MXO?2 hardware,
such as a Matrox WYSIWYG plug-in or Matrox A/V Tools (even if you’'ve
deactivated your I/O hardware using the hardware toggle button). Therefore,
it’s recommended that you always quit Avid Media Composer 6.0.x before
starting any other application that uses your MXO2 hardware. This issue is
fixed in Avid Media Composer 6.5. (Ref# VPG-1270)



If you’re using the RS-422 connector on your Matrox MXO2 hardware with
a Panasonic AJ-SD755 deck, you may get an error when batch capturing
clips. As a workaround, try using a suitable adapter (RS-232 to RS-422 or
USB to RS-422) to connect the serial device control port on the deck to your
computer. (Ref# VPG-4650)

When you open the Title tool using Avid Media Composer 6.0.x on Matrox
MXO2, the background in the Title tool does not update to show the video
on the Timeline. The video will be displayed after you scrub the Timeline
and click in the Title tool. This issue is fixed in Avid Media Composer 6.5.
(Ref# VPG-4336)

If you change the project format with the Capture tool open using Avid
Media Composer 6.0.x on Matrox MXO2, you’ll get an error and the
DNxHD formats won’t be available in the Capture tool. This issue is fixed
in Avid Media Composer 6.5. (Ref# VPG-4315)

If the video quality for playback in an SD project is set to anything other
than Full Quality using Avid Media Composer 6.0.x on Matrox MXO2, the
Title tool won’t display the background video. This issue is fixed in Avid
Media Composer 6.5. (Ref# VPG-2647)

If you experience errors relating to coincident points when using RS-422
device control with certain decks, set your deck preferences to relax
coincident point detection. To do this, click the Settings tab in the Project
window, double-click Deck Preferences, and then select Relax coincident
point detection. (Ref# VPG-1436)

In order to capture NTSC source video with audio in a project that has a
23.976p NTSC format, the video pulldown cadence for the project must be
set to standard 2:3:2:3. If you change the project type for a 1080p/23.976
project to 23.976p NTSC, you’ll need to change the video pulldown cadence
accordingly. To do this, click the Settings tab in the Project window,
double-click Film and 24P, and set Video Pulldown Cadence to
Standard, 2:3:2:3 pulldown. (Ref# VPG-1252)

For surround sound HDMI audio output, Matrox MXO2 outputs the low
frequency effects (LFE) track on channel 3 and the center (C) track on
channel 4. However, if you capture the HDMI surround sound output from
MXO?2 using your Avid editing application on another MXO?2 system, the
Avid editing application will assume that C is on track 3 and LFE is on track
4. This means that the C and LFE channels won’t be in the correct order in
your captured file. To play back and output your captured file correctly on
the MXO2 HDMI output, you can select Direct or Direct, surround tracks
in SMPTE order (depending on the version of your Avid editing
application) in the Audio Project Settings dialog box to map track 3 to
output channel 4 and map track 4 to output channel 3. (Ref# VPG-1606)
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* If the video input format selected for your video input source in the Matrox
Capture Settings dialog box doesn’t match your source video, after you
select the correct input format a slight glitch will occur in the video and
audio output, but then the output will be correctly restored. (Ref#
VPG-1720)

» Disconnecting and reconnecting a video input to your Matrox MXO2
hardware causes a temporary glitch in the video output. (Ref# VPG-1783)

¢ In order to perform an audio-only capture using Matrox MXQO2, you must set
the Input Type to Consumer-quality Source and select a component
video input source in the Matrox Capture Settings dialog box, although
the video input source doesn’t need to be connected. (Ref# VPG-1794)

Matrox A/V Tools

» If you are running multiple instances of Matrox A/V Tools, the video output
settings specified in the active A/V Tools session will also be used for all
other instances of A/V Tools that you are running. (Ref# 50865)

Matrox WYSIWYG plug-ins
* Only Matrox WYSIWYG output for graphics is supported for Adobe
Photoshop. (Ref# 51248)

Matrox Video for Windows (VFW) codecs
* Autodesk 3ds Max and Combustion 4 do not support exporting to a Matrox
.avi file with alpha (the alpha channel will be opaque). (Ref# 42251)

* If you want to use a Matrox VFW Uncompressed HD codec to render 10801
clips that you’ll be importing to Autodesk Combustion, you must render
video only (that is, the .avi file must not contain any audio). (Ref# 44598)

e When rendering to a Matrox NTSC .avi file using 3ds Max, the frame rate
for the video is automatically set to 30, and you can’t manually change the
frame rate to 29.97 fps, which is the required setting for NTSC video with
the Matrox VFW codecs. Therefore, your rendered Matrox NTSC .avi file
will be invalid. (Ref# 42190)

Matrox MAX H.264 encoding (MAX option)

* Matrox .mp4 files encoded using the Matrox MAX H.264 codec are
supported for playback using YouTube, Adobe Flash Player, QuickTime
Player, Apple iPad, Apple iPod, Apple iPhone, Apple TV, and Android
devices only. Matrox .264 files are supported for Blu-ray Disc authoring
using Adobe Encore only. (Ref# 54631)

* When you export to a Matrox MAX H.264 file with the Use Matrox MAX
hardware scaler option selected, such as when using a Matrox High
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Quality preset, make sure that your source media’s width and height are a
multiple of 16. (Ref# VPG-8199)

Matrox .mp4 files that have a custom frame size may display shifted with
black borders when played back using YouTube or certain other players. To
avoid this issue, set the width for your Matrox .mp4 file to 320, 480, 640,
720, 960, 1280, 1440, or 1920, and the height to at least 176 (the height must
be a multiple of 16). (Ref# VPG-3511)

If your Matrox .mp4 file has a width of 1024, you may have problems
playing the file using the native Android 4.0 video player. (Ref# VPG-4833)

If you created a Matrox .264 file containing complex video, such as for an
Adobe Premiere Pro sequence that contains complex Motion effects, Adobe
Encore may issue an error when you use this file to create a Blu-ray image or
burn a Blu-ray Disc. If this happens, try re-creating your Matrox .264 file
using Variable bit rate (VBR) encoding with a high Source video
complexity setting in the Matrox MAX H.264 Settings dialog box. (Ref#
VPG-1778)

You may see stuttering in the video displayed in the Preview Window of the
Matrox MAX H.264 Capture application on your computer monitor. This
issue, however, does not affect the video output or your captured file. (Ref#
55618)

When you export an Adobe Premiere Pro sequence to a Matrox MAX H.264
file, extra frames of black video may be added at the end of your exported
file. (Ref# 54399)

If you scale your source video when exporting to a Matrox MAX H.264 file,
the output frame size in the Source panel and the video preview and output
frame size in the Output panel of the Export Settings dialog box may not
be updated correctly. This issue, however, does not affect your exported file.
(Ref# 51511)

To avoid problems with playing back Matrox .mp4 files on Apple devices,
make sure that you have the latest software update available for your device
from Apple. (Ref# 51631)

When you export an Adobe Premiere Pro sequence that has chapter markers
to a Matrox MAX H.264 file, the chapter markers are not exported and
therefore won’t be available when you import your exported file to Adobe
Encore. (Ref# 51780)

If you want to transcode directly to Matrox H.264 Blu-ray format in Adobe
Encore, make sure you don’t enable the transcoding of assets using Adobe
Media Encoder. To check your settings in Encore, choose Edit >
Preferences > General, and make sure that the option to transcode assets
using Adobe Media Encoder is not selected (this option is disabled by
default). (Ref# 53710)
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* When transcoding directly to Matrox H.264 Blu-ray format in Adobe

Encore, you must set the audio Output Channels to Stereo, and the
Sample Size to 16-bit. (Ref# 54267)

If you’ve specified Matrox MAX H.264 transcode settings in Adobe Encore
and click Edit Quality Presets a second time to change the settings, the
settings under Video and Audio may be empty. If this happens, select a
different format from the Format list, then set the format back to Matrox
H.264 Blu-ray. You can then specify the settings that you want. (Ref#
54817)

* When you export a sequence that contains Matrox wipes in Adobe Premiere

Pro to a Matrox .mp4 file, the wipes in the resulting file may be blurry if the
source video was scaled for export (such as when downscaling an HD
sequence to an Apple iPod format). As a workaround, select Use Matrox
MAX hardware scaler when you perform the export. (Ref# 55253)
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